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Organisation and Conditions for Assessment 
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Organisation and Conditions for Assessment 

 

 
The assessment is designed to test the candidate’s ability to apply knowledge and understanding and 

practical skills, developed through study of the Relational Database Systems and Using Information 

Units.  The mark out of 60 should be submitted to the SQA unscaled.  This will be combined with the 

examination mark out of 140 to establish the candidate’s overall grade of award.  This mark should also 

be used in conjunction with internal examination marks or other evidence in the preparation of a 

candidate’s estimated grade of performance. 

 

The notional design length for the assessment is 8–10 hours.  However, a candidate may be permitted 

additional time if required. 

 

The assessment is to be undertaken under “open book” conditions, but under the supervision of a 

teacher or lecturer to ensure that the work submitted is the candidate’s own work.  The teacher or 

lecturer may give the candidate guidance and/or help if requested.  Any such help should be reflected in 

the marks awarded.  Once the task has been completed and marked, it should not be returned to the 

candidate for further work. 

 

These instructions are designed to be used in conjunction with data files provided with the electronic 

distribution of the task.  These can be downloaded from the SQA secure website. 

 

Two versions of a database are being supplied this year.  It is essential that candidates are issued 

with the correct version at the appropriate times.  They must not be given access to the second 

version until they have submitted answers to prior tasks. 
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Special Arrangements for Higher Coursework 2009-2010 

 

Centres are asked to pay special attention to the following arrangements. 

 

 
Candidates are not required to spend time entering data into a database.  Instead, the data should be 

prepared beforehand and provided to candidates by the centre. 

 

To facilitate this, Microsoft Access (2003 format) and Filemaker (v.7) files as well as a text (tab) 

delimited file have been provided.  It is intended that candidates will be provided with two versions of 

the database. 

 

The first database contains three of the tables of the system; Customer, Resort and Trail.  Each table 

will have all attributes correctly implemented although the tables will not be related.  Candidates will be 

required to create the Booking table from the completed data dictionary and then set up the 

relationships between all the tables.  Candidates will be required to submit a printout of the Documenter 

(or equivalent) of the Booking table only as evidence for Task 2(a).  Evidence for Task 2(b) could be 

generated from the Documenter again (selecting only Relationships in the options) but the evidence 

must show three correct one-to-many relationships.  Candidates will not use their database structures to 

complete Tasks 3-5.  Instead, centres should issue candidates with the second, fully populated database. 

 

The second database will be a complete implementation of the system.  This will include all 

validations, relationships etc – ie an exact implementation of the data dictionary provided to candidates 

at Task 2.  This working database should be issued to candidates after Task 2 has been submitted.  

Candidates must use this working database to complete Tasks 3-5. 

 

Microsoft Access and Filemaker files are provided.  Centres using other systems will require to create 

both versions of the database from the tab separated file provided.  This file can also be used if centres 

encounter any difficulties with the supplied Access or Filemaker databases. 

 

Additional notes follow which detail how candidate evidence is to be generated. 
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Notes: 

 

Candidates should be given a copy of the marking grid from Section 3 (not the detailed marking 

instructions) before starting the task so that they are aware of the mark distribution for each part. 

The entire Coursework Task consists of eight tasks.  Centres should take note of the points detailed 

below for each task. 

Task Evidence 

1 Hardcopy of proforma provided or can be produced by the candidate.  Task 1 must be 

completed and data dictionary handed in for marking before the materials for  

Task 2 are issued. 

 

2 (a) Documenter (MS Access) printout or equivalent showing table structure for the Booking 

table only – ignore “Format” for marking purposes. 

 

2 (b) Printout showing correct cardinality of relationships (Documenter in Access can be used 

to produce only the relationships information through the options). 

 

o In FileMaker Pro8, to get a printout of the design, candidates should 

adhere to the following instructions. 

(1) Select the “Define” option from the File menu and then select the 

“Database” option from the sub-menu. 

(2) Click on the Tables tab. 

(3) Highlight both tables by clicking on the name of the first table then 

holding down the shift key and clicking on the other table. 

(4) Click on the Print button. 

 

o In MS Access, to get a printout of the design, candidates should adhere to 

the following instructions.   

(1) Select the “Analyze” option from the Tools menu and then select 

the “Documenter” option from the sub-menu. 

(2) Select the table(s) required and then click Options button. 

(3) Make sure that the following options are checked/selected: 

• Include for Table 

 Properties 

 Relationships 

• Include for Fields 

 Names, Data Types, Sizes and Properties 

• Include for Indexes 

 Names and Fields 

(4) Required table design is displayed on screen and can be printed. 
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Task 2 (b) also requires a printout or hardcopy of the relationships. 

o Printing Relationships in FileMaker 8. 

(1) Select the “Define” option from the File menu and then select the 

“Database” option from the sub-menu. 

(2) Click on the Relationships tab then click on the Print button. 

o Printing Relationships in Access 

(1) Open the Relationships window. 

(2) Select the “Print Relationships” option from the File menu. 
 

3 Printout of report. 

 

4 Printout of report. 

 

5 Hardcopy that clearly shows use and details of macro or script (again, available through 

Documenter in Access – simply change options in dialogue box). 

 

6 Two spreadsheet printouts – one showing values, one showing formulae. 

 

Printouts should be landscape, may require to be resized and, in the case of the formulae 

printout, will run to at least two pages. 

 

7 Completed Gantt chart – sample answer was produced using MS Excel, however you 

may wish to use specific Gantt chart software which is freely available to download from 

the Internet.  Positioning of tasks is crucial – see detailed marking instructions for further 

explanation. 

 

Critical path should also be listed below chart along with calculated value for minimum 

project completion time. 

 

8 Single A4 printout of flyer. 
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Coursework Task: OneTwoSki 
 

 

Higher Information Systems Coursework Task 2009-2010 

 

Background 
 

OneTwoSki is a company that owns and manages a number of ski resorts in Canada.  All resort details 

are stored as part of a relational database in a table called Resort.  Resort names are unique and some of 

the resorts have spa and/or crèche facilities.  Each resort has a resort manager who stores customer 

bookings in the centralised relational database. 

 

When a customer first makes a booking they must provide their ski ability level (Beginner, Intermediate 

or Expert) in addition to their contact details.  This information is stored by OneTwoSki in a Customer 

table. 

 

Customer bookings are made by a party leader and each party booking is made for skiers of the same 

ability.  Details of customer bookings are stored in a Booking table.  Each booking is allocated a unique 

6-digit number.  Other details stored include information on the number of people staying, the duration 

of the stay and the number of ski days booked.  The minimum stay is three days and no booking is 

allowed for more than two weeks.  Ski passes for ski days are available as 3-day, 5-day, 7-day, 10-day 

or 12-day tickets.  Arrival dates are stored in the form dd/mm/yyyy. 

 

The company pride themselves on the information they can offer to their customers about the ski trails 

available in each of their resorts.  All ski trails are allocated a colour which indicates its level of 

difficulty as follows: 

 

Green Beginner 

Blue Intermediate 

Red Advanced 

Black Expert 

 

Each ski trail is assigned a unique ID number along with information about is name, colour and 

length (km).  These details are stored in the Trail table. 
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The normalised data model for OneTwoSki was produced and a surrogate key, Booking Ref, was 

introduced to the Booking table to simplify the implementation. 

 

The resulting data model is shown below where primary keys are shown in bold and underlined, while 

asterisks (*) indicate foreign keys.) 

 

Customer  
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Resort (Resort, Resort Manager, Resort Address, Spa, Crèche) 

 

Booking (Booking Ref, Customer ID*, Resort*, Arrival Date, Persons, Nights, Ski Days) 

 

Trail (Trail ID, Resort*, Trail Name, Colour, Length (km)) 

 

The entity-relationship diagram for the system is shown below. 

Customer Booking Resort 

(Customer ID, Firstname, Surname, Street, Town, Postcode, Ski Level) 

Trail 
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The data dictionary for the Customer, Resort and Trail tables is shown below, followed by a partially 

competed data dictionary for the Booking table. 

 
Entity Attribute PK/ FK Data 

Type/Size 

Unique Required Validation Format 

Customer CustomerID PK Number Y Y >=1 and <=9999 0000 

 Firstname  Text (15) N Y   

 Surname  Text (20) N Y   

 Street  Text (30) N Y   

 Town  Text (20) N Y   

 Postcode  Text (8) N Y   

 Ski Level  Text (12) N Y Restricted (Beginner, 

Intermediate, Expert) 

 

Resort Resort PK Text (20) Y Y   

 Resort Manager  Text (35) N Y   

 Resort Address  Text (50) Y Y   

 Spa  Boolean N Y   

 Crèche  Boolean N Y   

Trail Trail ID PK Number Y Y >=1 and <=999 000 

 Resort FK Text (20) N Y Lookup from Resort  

 Trail Name  Text (30) N Y   

 Colour  Text (5) N Y Restricted (Green, 

Blue, Red, Black) 

 

 Length (km)  Number N Y   

 
Booking  

Attribute PK/FK Data 

Type/Size 

Unique Required Validation Format 

Booking Ref PK Number Y Y A 000000 

Customer ID FK Number N Y B 0000 

Resort FK Text (20) N Y C  

Arrival Date  Date N Y  dd/mm/yyyy 

Persons  Number N Y   

Nights  Number N Y D  

Ski Days  Number N Y E  

 

 

 

Task Evidence Required 

1 Using the background information provided in the introduction 

to the task, complete the data dictionary entries for the Booking 

table. 

Completed data 

dictionary 

 

You must now submit your answer to Task 1 to your teacher/lecturer. 
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Before attempting the tasks in this section ask your teacher/lecturer for a completed data 

dictionary.   

 

You will also need access to pre-prepared database tables.  

 

You MUST complete tasks in the sequence indicated. 

 

 

Task Evidence Required 

2 Database tables have been created for the Customer, Resort and Trail entities. 

 (a) Using the completed data dictionary issued by your 

teacher/lecturer, create the Booking table.  You should 

pay particular attention to: 

• data type 

• unique 

• required 

• validation 

• primary and foreign keys 

 

Hardcopy (printout or 

screenshots) of 

Booking table 

structure including 

field types, validation 

checks etc. 

 (b) Set up/edit the relationships between all the tables as 

indicated by the entity-relationship diagram. 

Hardcopy (printout or 

screenshots) of 

relationships between 

tables – evidence 

must show correct 

cardinality 

 
You must now submit all hardcopies for Task 2 to your teacher/lecturer. 
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Ask your teacher/lecturer for the complete database.  This database must be used to carry out 

Tasks 3-5. 

 

You work in the head office of OneTwoSki.  Part of your job is to deal with customer queries.  Use the 

database provided to produce reports for the following requests made by customers. 

 
Task Evidence Required 

3 An expert skier wanted to know which resorts were booked 

most often by people with his ski ability, so the following report 

was produced. 

 

 
 

Another request has come in asking you to provide a similar 

report that shows the most popular resorts with Intermediate 

party leaders. 

 

The list should be sorted with the most popular resort first.  

Where two or more resorts have the same number of bookings, 

they should be sorted alphabetically. 

 

The total number of bookings should be displayed at the bottom 

of the report. 

 

Printout of 

report/layout 
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Task Evidence Required 

4 A customer wanted to know the total lengths of the different 

trail colours at the BlackBear resort, as well as the total trail 

length for the resort. 

 

OneTwoSki provided the following report. 

 

 
 

Another customer has asked you for the same information about 

trail lengths but wants this for all resorts that have crèche 

facilities.  The information should be sorted by resort and the 

trail details for each resort should be displayed with the colour 

of trail with the longest length first.  Trail lengths should be 

displayed to one decimal place. 

 

Printout of 

report/layout 

 

 

Task Evidence Required 

5 A customer has requested a quicker way of navigating through 

the list of ski trails available. 

 

You have been asked to design a new form/layout for the Trail 

table that includes navigation buttons to skip forward and back 

10 trails at a time.  When you click on the forward button, for 

example, the pointer or cursor should skip to the 10th
 record 

then the 20
th
 record, and so on.  The new form/layout does not 

necessarily have to display only 10 trails at a time – it should 

simply allow this quicker method of navigation. 

 

These buttons should make use of a macro or script to control 

the navigation. 

 

Screenshots of 

form/layout 

 

Printout of macros/ 

scripts used to control 

navigational features 
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One of your other responsibilities in head office is to prepare a range of financial statements for both 

the company and customers.  The CloudyBay resort has provided you with a list of customer bookings 

and you have to prepare customer bills. 

 

You have been provided with a template spreadsheet and have been asked to generate the customer bills 

by completing columns H through to M for the twelve listed bookings. 

 

The columns are detailed as follows. 

 

H Ski Pass Price (pp) The price of each ski pass per person – dependent on the number of ski 

days – values obtained from cells A17:B22. 

I Total Ski Price The sum of ski passes for all persons in the party. 

J Accomm (pppn) Accommodation price per person per night – dependent on the number 

of nights stayed – values obtained from cut-off ranges in cells D17:E22. 

K Accomm (total) Total accommodation charge for the party as a whole. 

L Discount (accomm) Discount that may apply to the accommodation total, dependent on the 

number of persons in the party 

M Total Bill Total bill of ski passes, accommodation and any discount that may 

apply 
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Task Evidence Required 

6 Using spreadsheet software with which your are familiar, create 

the set of customer bills for the CloudyBay resort using the 

specification below. 

 

(a) 

 

 

 

The spreadsheet should make use of lookup functions to 

automatically insert prices for the type of ski pass price 

(per person) purchased and the accommodation per person 

per night (pppn) using the data shown in the template. 

 

(b) Customers can qualify for additional discounts on their 

accommodation depending on the number of persons in 

the party. 

 

There is no discount available if there are less than four 

people in the party.  If there are four or more in the party 

there is a discount of 5%.  If there are six or more in the 

party the discount is 10% and if there are more than eight 

in the party, the maximum discount of 15% applies. 

 

Your spreadsheet should make use of a nested IF to 

calculate what discount, if any, applies to each customer’s 

accommodation bill.  

 

 

(c) The total bill for each customer should take into account 

the cost of their ski passes, accommodation and any 

discount that may apply to the accommodation. 

 

 

Two printouts 

 

– one printout 

showing values 

 

– one printout 

showing formulae 

 

printouts should be 

landscape, may 

require to be resized 

and, in the case of 

the formulae 

printout, will run to 

at least two pages 
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OneTwoSki is planning to open a new resort and has identified the tasks that need to be completed for 

the project to be a success. 

 

As part of the project management of building the new resort, head office has asked that you prepare a 

Gantt chart of all the tasks involved. 

 

The table below details the tasks required to build the new resort, including the minimum time each task 

requires to be completed.  The table also identifies which tasks need to be completed before the next 

task can be started.  

 

Task Details Immediate  

Predecessor 

Duration (weeks) 

A Inform existing/potential customers – 6 

B Design drawings for the resort produced – 4 

C Create promotional flyer B 3 

D Apply for Planning Permission B 2 

E Planning Permission obtained D 4 

F Select building contractor B 4 

G Construction of new resort E,F 15 

H Advertise for staff – 4 

I Appoint staff for new resort H 4 

J Secure bookings for new resort A,C 10 

K Hotel opens G,J,I 1 
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Task Evidence Required 

7 Using suitable software create a Gantt chart that represents the 

project to build the new resort.  (A sample chart has been 

started and is included below.) 

 

Using the timings provided, calculate the minimum time to 

complete the project; ie the critical path.  State the critical path 

of the project by listing the tasks in the order in which they 

must be completed. 

 

Include a statement below your Gantt chart that lists the critical 

path and shows the minimum time for the project to be 

completed. 

 

Printout showing 

complete Gantt 

chart with critical 

path highlighted/ 

listed and minimum 

time for project 

completion 

 

Sample Gantt chart (incomplete). 
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The marketing of the new resort requires the production of a promotional A4 flyer.  Head 

Office have decided on a layout for the flyer as is shown below. 

 

 
 

They have also provided you with some data files and asked that you create the promotional flyer using 

the specification detailed below. 

 

Task Evidence Required 

8 Using the files provided, create an A4, single sheet, 

promotional flyer for the new resort ensuring that: 

 

• the OneTwoSKi logo, imported from the file provided, 

is to be used as the heading and covers the width of the 

page 

• the body text, imported from the text file provided, is 

an appropriate size to ensure it is readable and fits on 

one page and a sans-serif font is used throughout 

• the body text has to flow across three evenly spaced 

columns 

• SkiPic1.jpg should have tight wrap applied so the text 

flows around the shape of the skier across columns 1 

and 2 

• SkiPic2.jpg requires some of the blue ski to be cropped 

and should have square text wrap applied across 

columns 2 and 3. 

 

Printout of flyer 
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Marking Grid 
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Marking Grid 
 

 

Name   Date     

 
 

Task Possible 

Marks 

Actual  

Marks 

Evidence Comment 

1. 5  Completed data 

dictionary 

 

2.(a) 4  Printout of table 

structure 

 

2.(b) 3  Printout showing 

relationships 

 

3. 6  Printout of report  

4. 8  Printout of report  

5. 4  Printout of 

macros/scripts 

 

6. 12  Values printout  

Formulae printout 

 

7. 10  Printout of Gantt 

chart 

 

8 8  Printout of flyer  

 60 

 

   

 

 



Appendix 1 

 

Task 1 Proforma 

 

 

Name  

 

Data Dictionary Entry 

 

 

A 

 

 

 

B 

 

 

 

C 

 

 

 

D 

 

 

 

E 
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Appendix 2 

 

Completed Data Dictionary 

 

Only to be issued after completion and submission of Task 1 

 
Entity Attribute PK/ FK Data 

Type/Size 

Unique Required Validation Format 

Customer CustomerID PK Number Y Y >=1 and <=9999 0000 

 Firstname  Text (15) N Y   

 Surname  Text (20) N Y   

 Street  Text (30) N Y   

 Town  Text (20) N Y   

 Postcode  Text (8) N Y   

 Ski Level  Text (12) N Y Restricted (Beginner, 

Intermediate, Expert) 

 

Resort Resort PK Text (20) Y Y   

 Resort Manager  Text (35) N Y   

 Resort Address  Text (50) Y Y   

 Spa  Boolean N Y   

 Crèche  Boolean N Y   

Trail Trail ID PK Number Y Y >=1 and <=999 000 

 Resort FK Text (20) N Y Lookup from Resort  

 Trail Name  Text (30) N Y   

 Colour  Text (5) N Y Restricted (Green, 

Blue, Red, Black) 

 

 Length (km)  Number N Y   

Booking Booking Ref PK Number Y Y >=1 and <=999999 000000 

 Customer ID FK Number N Y Lookup from 

Customer 

0000 

 Resort FK Text (20) N Y Lookup from Resort  

 Arrival Date  Date N Y  dd/mm/yyyy 

 Persons  Number N Y   

 Nights  Number N Y >=3 and <=14  

 Ski Days  Number N Y Restricted 

(3,5,7,10,12) 
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Appendix 3 
 

 

 

 

 

 

 

Detailed Marking Instructions 
 

Strictly Confidential 
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Detailed Marking Instructions – Do not issue to candidates. 

 
    Marks 

1 A – Booking Ref Validation (>=0 and <=999999) 1 

 B – Customer ID Validation (Lookup from Customer)  1 

 C – Resort Validation (Lookup from Resort) 1 

 D – Nights Validation (>=3 and <=14) 1 

 E – Ski Days 

5 

Validation (Restricted (3,5,7,10,12)) 1 

7 attributes all correct 4 

6 attributes correct 3 

5 attributes correct 2 

4 attributes correct 1 

2 

Create Booking table  4 

<4 attributes correct 0 

 Links between tables 3,2,1,0 3 correct one-to-many relationships  

Intermediate bookings only (correct data) 1 

Count of bookings 1 

Total intermediate bookings 1 

1
st
 sort condition (Booking Desc) 1 

2
nd

 sort condition (Resort name Asc) 1 

3 

Most booked resorts 

for Intermediate 

skiers 

6 

Only required fields shown (Resort and Booking) 1 

Grouped by Resort 1 

Sum of trail lengths 1 

Crèche resorts only 1 

Total trail length for resort 1 

1
st
 sort condition (Resort Asc) 1 

2
nd

 sort condition (trail length Desc) 1 

Trail lengths displayed to 1 decimal place 1 

4 

Trail lengths of 

resorts with crèche 

facilities 

8 

Only required fields (Resort, Colour, Length) 1 

Next button – 1 mark button, 1 mark increment  5 Navigate Trail table 

10 at a time 
4 

Prev button – 1 mark button, 1 mark increment  
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    Marks 

Lookup for Ski 

Pass 

2 Must have absolute ref or named ranges 

Award 2 marks if completed with no help 

Award 1 mark if some help required 

 

Lookup for 

Accom (pppn) 

2 Must have absolute ref or named ranges 

Award 2 marks if completed with no help 

Award 1 mark if some help required 

 

Total Ski Price 1   

Accom Total 1   

Discount – 

nested IF 

5 Eg IF(E2>8,K2*0.15,IF(E2>=6,K2*0.1,IF(E2>=4,K2*0.05,0))) 

 

IF(E2>8,K2*0.15 

IF(E2>=6,K2*0.1 

IF(E2>=4,K2*0.05 

0))) 

 

No help required 

 

 

 

1 

1 

1 

1 

 

1 

6 

Total Bill 1   

7 

Gantt Chart 

10 10 correctly positioned tasks (B-K)  

9 correctly positioned tasks  

8 correctly positioned tasks  

7 correctly positioned tasks  

6 correctly positioned tasks  

5 correctly positioned tasks  

4 correctly positioned tasks  

3 correctly positioned tasks  

<3 correctly positioned tasks  

 

Critical Path identified as B-D-E-G-K  

 

Critical Path calculated as 26 weeks  

 

8 

7 

6 

5 

4 

3 

2 

1 

0 

 

1 

 

1 

8 

DTP – flyer 

8 Import heading and use page width  

Import text file  

Body text appropriate size (readable)  

All body text visible on one page  

Sans-serif font throughout  

3-column text flow  

SkiPic1 position and text wrap 

SkiPic2 position and text wrap 

 

1 

1 

1 

1 

1 

1 

1 

1 
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Screenshots showing solutions to Tasks 1, 3, 4, 6, 7 and 8 
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Task 1 

 
Booking  

Attribute PK/FK Data 

Type/Size 

Unique Required Validation Format 

Booking Ref PK Number Y Y >=1 and <=999999 000000 

Customer ID FK Number N Y Lookup from Customer 0000 

Resort FK Text (20) N Y Lookup from Resort  

Arrival Date  Date N Y  dd/mm/yyyy 

Persons  Number N Y   

Nights  Number N Y >=3 and <=14  

Ski Days  Number N Y Restricted (3,5,7,10,12)  

 
Task 3 
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Task 4 
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Task 6  
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Task 6 (continued) 
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Task 6 (continued) 
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Task7  

 

 
Indicates critical path: B-D-E-G-K 

 

Task Position 

B must be weeks 1-4 

C any 3 weeks after week 4 but must be completed by week 15 

D must be weeks 5-6 

E must be weeks 7-10 

F any 4 weeks between weeks 5-10 

G must be weeks 11-25 

H any 4 weeks but must be completed by week 21 

I any 4 weeks between weeks 5-25 but must start after H 

J any 10 weeks between weeks 8-25 but must start after both A and C 

K must be week 26 

 

Minimum time for project completion – 26 weeks (B+D+E+G+K) 
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Task 8 

 
Sample Flyer – provided as part of sample answers as a guide only 
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